
Extra Class Training System 

By Eugene Morgan (WB7RLX) 

I have been considering for some time trying for my Extra Class ticket.  So when I heard the club was 

sponsoring an Extra Class online training I decided that now might be the time.  The first thing I did was 

order the “ARRL Extra Class License Manual”, aka: the Big Green Book.  Throughout this article I will 

refer to it as the “Big Green Book.” In addition I arranged to borrow the companion book, the “ARRL 

Extra Q&A” book, aka: the Little Green Book.  I found both to be very good but also very different. 

The big green book presented each sub element in an extensive deep dive into each topic associated 

with each element of the modules.  It was clear the goal was to help the reader develop good 

understanding of the concepts behind each question.  It’s was clear that the Big Green Book was about 

communicating and teaching the concepts, not about memorizing answers.  Consequently the answers 

to the questions are somewhat scatters about in each chapter and in some cases across multiple 

chapters. 

The Little Green Book on the other hand went question by question, in sequential order and provided 

more of an abstract of the concepts for each question.  I found both books helpful, complementary to 

each other, and necessary.  However I did find in a few rare instances where the text in both books was 

lacking and in some cases Wikipedia had a better explanation and other cases the ARRL Antenna 

Handbook had the better explanation. 

Then after attending a few classes I found that yet another book provided a different approach 

altogether and included some fun and interesting hints and methods for remembering some of the 

answers.   That book is by Craig Buck and is titled, “Pass Your Amateur Radio Extra Class Test – The Easy 

Way.” 

Can I say one was better than other, no.  It would depend on your learning style.  And having to pick just 

one would not be fair to the other two, all three were very good and I’m sure almost anyone using any 

one of the three books would do fine when it came time for the test. 

Of course the next consideration was all of the various online resources.  Some are free, some require a 

subscription. I looked briefly an a couple but decided that I would write my own.  Why you might ask 

when there is some much available online, a good question. 

If any of you have been to my QRZ site you will find that I have written a lot of the software I use.  The 

key reason for that is to keep my brain from turning to mush.  In my job before retiring I use to write a 

lot of utilities that made my job easier and that allowed my project and program managers to be more 

effective at managing their various projects.  I found that writing programs as well as building some 

fairly sophisticated Microsoft Excel tools was in some sort of twisted way, a form of relaxation for me, 

the way crossword and Sudoku puzzles are for some people.  After several months of retirement it was 

clear I was starting to get soft in the brain. The other reason for writing my own program is I wanted to 

capture all of the good tips and tricks for studying and passing the Extra Exam.  I found that they were 

not all included in one book or on one web site.  I found that there was good information scattered 

across the web and in many books and not just those specific to passing the Extra Class test. 

https://www.amazon.com/Extra-Class-License-Manual-Spiral/dp/1625951310/ref=sr_1_6?dchild=1&keywords=Extra+Class+Study+Guides&qid=1619987599&sr=8-6
https://www.amazon.com/ARRLs-Extra-Q-ARRL-Inc-ebook/dp/B08B1MFR75/ref=sr_1_2?dchild=1&keywords=ARRL+Extra+Class+Q%26A&qid=1619987699&sr=8-2
https://www.amazon.com/ARRLs-Extra-Q-ARRL-Inc-ebook/dp/B08B1MFR75/ref=sr_1_2?dchild=1&keywords=ARRL+Extra+Class+Q%26A&qid=1619987699&sr=8-2
https://www.amazon.com/Pass-Amateur-Radio-Extra-Class/dp/B0858WK5V2/ref=sr_1_2?dchild=1&keywords=Extra+Class+Study+Guides&qid=1619987555&sr=8-2
https://www.amazon.com/Pass-Amateur-Radio-Extra-Class/dp/B0858WK5V2/ref=sr_1_2?dchild=1&keywords=Extra+Class+Study+Guides&qid=1619987555&sr=8-2


The Feature Set 

I knew the programming would be fairly easy and that the real work would be in developing what I call 

the hints file or better yet the hints database.  Following what in the software business we call the 

Functional Requirements, or as I like to say, the feature set.  Unlike other programs I have written in the 

past where I made it up as I went, this time I had a very specific set of goals before writing a single line 

of code.  However I will admit to adding a couple of features toward the end of development cycle 

based on feedback obtained during several Zoom sessions. 

The Extra Class Training System Feature Set: 

 Give the user the ability to select a specific sub element to focus on.  Why waste time on 

modules already mastered? 

 Allow the user to go through the sub element questions in sequential order or in random order. 

 If the user selected sequential they could also specify which question they want to start with.  

The thinking behind this was to make the program more useful in a multi student teaching 

environment such as our weekly zoom sessions. 

 The answers were to be presented in a random order.  This would require the user to know the 

correct answer not just that it’s just always A,B,C or D. 

 Provide immediate feedback if the user missed a question during a drill.  Upon missing a 

questions the question would be put back into the question pool.  This would require the user to 

ultimately answer the missed question correctly before ending the module. 

 Provide the user a way to see the answer, I call this the “Peek” feature.  It displays the correct 

answer A,B,C, or D but provides no explanation.  I also wanted to be able to toggle this feature 

on or off at the press of the space bar or a mouse click. 

 Allow the user to ask for a hint.  The hint would provide an explanation of the concept and 

provide the correct answer and if available a memory trigger or a simple way of remembering 

the answer. 

 Give the user the ability to edit the hints database so they can add their own hints and memory 

triggers. 

 Provides the user the ability to take a simulated practice test that looks and behaves exactly the 

way the real test works with one exception. 

 The one exception is the way the “Review” function works.  Like the real test when the user 

selects “Review” the program displays a list of the question numbers and the users answer for 

each of the questions.  It also shows which questions have not been answered.  My program 

takes this one step further, it actually shows you what questions you have missed and your 

current score based on the questions that have been answered. 

 The program must be able to display accompanying graphics given that some of the test 

questions are specific to certain graphics.  This feature is also available in the practice test as 

well as in the sub element drills. 

The Program 

Now that we have looked at the programs feature set let’s take a quick look at the program.  Figure 1 

shows the main menu.  From this menu you can pick which sub element you wish to drill on or you can 



select to take a practice test.  You can use your mouse or the keyboard to select what you want to do.  

You exit the program by clicking on the ‘X’ in the top right corner of the screen, as is customary for all 

Windows programs. 

If you choose to do a sub element module you will be asked if you want the questions presented in a 

random order or in a sequential order.  If you select [R]andom you will go immediately into the drill.  

Questions will be presented in a random order until you have answered all questions correctly or until 

you select [Stop Drill].  Note that missed questions will be put back into the rotation and will be 

presented again randomly during the drill. 

If you selected to have the questions presented sequentially you will be asked which question you want 

to start with, in most cases this will be question one.  This feature was added after a couple of Zoom 

sessions.  It was clear that presenting the questions in order was necessary so attendees could follow 

along more easily if they were running their own copy of the Extra Class Training System during the 

training class or using one of the many study guides. 



 

Figure 1: The Main Menu 

 

Peek Feature: During a sub element session you can toggle the peek feature on or off by either tapping 

the Space Bar or clicking “Peek On” to turn the peek feature on, or click on “Peek Off” to turn the peek 

feature off.  With the peek feature enabled the answer will appear to the left of the question ID in the 

top left portion of the screen.  In Figure 2 note the letter “C” next to the question ID, 

 



 

Figure 2:  Sub element Drill - Peek On 

Hint Feature: During the drill if you find you need some help with a question you can ask for a hint by 

clicking on “Hint” or pressing the “H” key.  Refer to Figure 3.  For this particular question not only is an 

explanation given but also a clever hint, “Very high Fry-ability.” 

 



 

Figure 3: Sub Element Drill showing the hint. 

 

Practice Test:  The other feature of the program is the practice test.  Refer to Figure 4.  The practice test 

has been designed to act and feel the same as the real test.  Questions are selected at random from 

each sub element, with one question coming from each sub group.  The questions are presented in 

random order and the answers are also presented in a random order.  In short no two tests should ever 

be alike.  Refer to Figure 4. 

And like the real test you can skip a question and go back to a question at any time.  However the review 

feature behaves a little differently than the real test.  



 

Figure 4: The Practice Test 

 

The Practice Test, the Review Feature:  Please refer now to Figure 5.  Given this system was intended to 

be a training tool it was necessary that it provide some level of feedback.  To that end the review feature 

works a little differently than the real test.  To begin you can toggle the review feature on or off.  You 

can leave it on during the test so as to show you every time you miss or correctly answer a question.  Or 

you can toggle it off and only review your status when you feel it beneficial to do so.  Simply toggle it on 

or off by clicking on the review button or pressing “R”. 

The Review feature will show you the questions you have missed in red and show you your score based 

on the questions that you have answered, see Figure 5. In referring to Figure 5 I have clearly not done 



very well on this practice test, I answered 40 questions and only got 10 correct for a failing score of 25% 

on the questions that I actually answered.   Questions that were not answered are blank so before 

ending the test one should go back to the unanswered questions and complete them.  In the real test, 

missed questions are not deducted from the total of 50 questions.  Your actual score in the real test is 

based in the number of correct answers out of a possible 50 questions.  A skipped question is the same 

as an incorrect answer in the real test. 

Finally you can of course end the test at any time by selecting Stop Exam.  Note also that when you have 

answered all 50 questions the program will inform you and then let you decided if you want to review 

and possibly change some of you answers or revisit any questions you might have skipped over or simply 

stop the test and get your final score. 

 



 

Figure 5: The Practice Test - The Review Feature 

Overall the program is pretty simple to operate, the goal after all, was to study and get ready for your 

exam and not waste a minute figuring out how to use the program. 

 

Customizing the Hint’s Database 

One of what I think is one of the most important features of the program is the ability to add your own 

hints and graphics to the hints database.  Although the program comes with a fairly robust set of hints 

and graphics you can also add your own or add your own embellishment to the existing hints.  This 

section will explain how to include your own hints and graphics. 



To begin the hints database is nothing more than a text file which means it can be edited using a 

common text editor such as Windows Notepad or a more feature rich text editor such as Notepad++. 

You should not use a program like Microsoft Word, however if you do, make sure you save the file as a 

DOS text file. 

You will find the hints.txt file in the directory where you installed the program.  Let’s begin by opening 

the file and examining a typical line.  The each line has a fairly specific format: 

Hint ID: [Page Reference] followed by that hint text, refer to Figure 6.  The hint ID is the question 

reference number used in the Big Green Book.  The Hint ID format is ‘E’ for Extra, the Sub element 

number, followed by the sub element group ID, and finally the question number in the group, example 

the Question ID for E1A01 would be specific to a question from the Extra Class question pool, from sub 

element 1 on Commission Rules, and from group A which is about Operating Standards in regard to 

frequency privileges and specifically question 1 about legal carrier frequencies.  See page 13-4 in the Big 

Green Book. Note that the page reference included in the provided hints database is specific to the Big 

Green Book.  You can however include not only the page reference between the brackets but a book 

reference as well, example: [ARRL Antenna Handbook, 24th Edition, page 21-4] 

A hint cannot be on more than one line and cannot be more than 1425 characters in total length.  You 

do not need to put a blank line between hints.  In the example below the blank lines were added only to 

make the file more readable.  If there is a graphic associated with the hint the reference will be placed at 

the very end of the line and will be in the form of: ~Figure E1A01.bmp  In this example the actual 

graphic is named E1A01.bmp and is located in the “Figures” sub folder under the main installation 

folder.  All graphic files must be in a bit map format, aka: a .bmp file. 

As long as you follow the prescribe format you can add as many hints as you like.  However, only one 

hint per question.  You are also welcome to edit the hints file and add whatever hints you have found 

useful.  I also encourage you to send any hints you might want added to me for inclusion in future 

updates to the hints database. 

 



 

Figure 6: The Hints.txt file 

 

 

Installation 

The program is pretty easy to install.  To give you a thumbnail of the process, after downloading it from 

the OARC web site, unzip the file and run the setup utility and then modify the shortcut.  The steps 

below will walk you through the process in a bit more detail.  If you have any issues please drop me a 

note and I will be happy to help you.  Before beginning the installation the program let’s make sure you 

have the right hardware and operating system. 

Program Requirements: 

Required: A computer running Windows.  This program was developed using Windows 10 but there’s no 

reason it shouldn’t run under Windows 7 or even Windows XP. 

Required: Disc space and memory requirements are minimal, just under 85 Mb of disk space.  In terms 

of memory the program is fairly small, the memory foot print is around 4Mb and CPU utilization is under 

.5%.  So in terms of computer resources the requirements are minimal.  

Required:  A desire to learn and the time necessary to practice. 

 

Installation Instructions: 

 Download the program from the OARC web site.  It should be located in the down load area on the 

OARC web site see: http://ogdenarc.org/downloads.html.  If a class is being offered a link will be 

http://ogdenarc.org/downloads.html


provided on the OARC home page just under the link to the Zoom meeting invite.  It can also be 

found under Member downloads by Eugene Morgan.  After you have downloaded the file unzip it 

and run the ExtraSetup.exe.  If you are reading this article make sure you also do the next two steps.   

 The next step requires that we configure the Extra Class Training System window size.  On your 

desktop you will find the “Extra Test” icon.  Right Click on it and select Properties.   In the properties 

window you will see a number of tabs, click on the Layout tab. In the middle of the Layout Tab 

window you will see a box labeled Windows Size.  Set the Width: to 100 and the Height: to 43. 

 While you have the shortcut open next select the [Options] tab. Uncheck the [Quick Edit Mode] 

option. Then click on the [Ok] button.  At this point you can run the Extra Class Practice program. 

Just In Case You See A Warning From Windows Defender or other Anti-Virus program:  When 

executing or installing the program for the first time you may experience a warning from Microsoft 

Defender or your anti-virus software warning you about this program. Don't worry.  In the case of 

Microsoft Defender just click on the "More info" link then click on the "Run anyway" link. This only 

occurs the very first time the program is launched and only on some computers.  I take extreme 

precautions to make sure that none of my programs are infected and scan each before sending on to the 

clubs Web Master. 

 

Acknowledgements: I would call out two of our peers that helped me during the development and beta 

testing.  Justin Hall (KP7LAK) for feedback, the loan of the Craig Buck book complete with highlights and 

notations as well as beta testing the various versions.  I would also like to thank Rick Morrison (W7RIK) 

for some help explaining what the real test looks like, beta testing and providing feedback.  I also need 

to send a thank you to Pete Heisig (AI7GV) for loaning me his copy of the little green book, which was 

well mark and truly broke in as well.  Pete also shared with me his memory of the test screens.  I can’t 

express my thanks and appreciation to these three enough.  Their testing, their input, and their recall of 

the test itself was a big help in getting the program to its final state.  A heartfelt thanks Guys! 

Future Plans and Possible Updates:  I will continue to refine and update the hints database over time 

and have arrange with the clubs Web master to post these updates in the future.  I will also send out 

updates to the hints file for those who I know are using the program.  Once I complete the Extra Class 

Training System I will also provide a version for the Tech class and the general class courses.  I hope to 

have them ready for the next round of testing in the fall if not sooner. 

In Closing: I know there are a lot of good resources out there in the form several books, many not 

mentioned here, as well as a host of web sites.  Regardless, I hope you will find my program just as 

helpful if not more so.  If you decided to use my program then please accept my sincere thanks. 

If you have any questions or if you have some ideas about additional features or improvements give me 

a call.  If you find any bugs please do contact me with the specifics.  If you are interested in seeing the 

source code or doing a deep dive into the code drop by, I love talking about this stuff.  Above all and 

most importantly to me, I hope you enjoy using my program. 

73, 



Gene 

(WB7RLX)   

 


